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Click on the 
drop-down 
arrow on the 
Task Pane for 
other options. 

Prerequisites   
• Ability to navigate, confidently, the file structure of a hard drive 
• Be fluent using the Open and Save dialogue windows 
• Understand the concept of file formats 

Summary of this Word XP Quick Guide 
This document is an overview of some of the more common features in Word XP that a skilled user 
should be able to use fluently.  It is not intended to serve as a step-by-step tool to teach the Word 
software.  The order that the topics appear does not have any significant bearing on when the tools 
would be used in Word.  Tip: When creating a Word document, you may save time by entering the data 
first and formatting towards the end. 

Parts of the Word XP Window 
 

New Components in XP 

The Task Pane 
This provides fast access to many tools  
and appears automatically 
Manually Open the Task Pane 
• Open the View Menu and choose Task Pane 

Ask a Question Box 
Located in top right corner – ready to help 

Toolbars 
Status Bar 

Menu Bar 

Ask a Question Box 

Task Pane 

Title Bar 

Tab Stop type indicator 
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Create New Documents 

Blank Document 
• Open Word, or click the New button in an existing Word document 

Templates and Wizards 
Template: Pre-designed layouts with space-holders for your information 
Wizards: Word asks a series of questions and provides a layout with the data inserted and extra place-
holders for additional information 

Access the Templates and Wizards 
1. Open Word 
2. Open File Menu and choose New 
3. Make a selection from the Task Pane 

Viewing a Word Document 
 Word document may appear very differently based upon the view. 

Menu Options 
By default, Word shows the items within each menu that a user 
uses the most.   

View All Menu Items 
• Click the expand button at the bottom of the menu 

Configuration Settings for the Menus 
• Tools / Customize / Options tab 

 

Common Error: In Normal view, page boundaries, headers and 
footers, backgrounds, drawing objects, and pictures that do not 
have the “In line with text” wrapping style do not appear. 
 
Tip: Print Layout is the best view to see an accurate 
representation of the printed document on the screen  
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Good choice for last names, etc. 

2. Click on the word that should 
replace the underlined word 

Toolbars 
The suggested toolbars are Standard, Formatting, and Drawing 

Locating a Button Not in View 
If the toolbar is wider than the space allotted, Word will hide some of the buttons 
• Click on the Toolbar Options button (right edge of toolbar)  

Change the Visible Toolbars 
1. Right-click any toolbar 
2. Select the toolbars as desired 

Move a Toolbar 
1. Grab the toolbars handle and drag to new location 

Warning Indicators 

Red Wavy Underline 
The underlined word is not in the dictionary or it is a duplicated word  
1. Right-click the underlined word and make a choice 

Green Wavy Underline 
The word or group of words does not appear correct to the grammar checker 
• Right-click on phrase to review options 
Tip: Word grammar suggestions are not always correct 

Blue Wavy Underline 
The formatting for that section is not consistent with the rest of the document 
• To activate: Tools / Options / Edit tab / Mark formatting inconsistencies 
 

Handle of 
a toolbar 



Illinois Wesleyan University – Department of Information Technology 

Page 5 of 15 © tjm2001 

Customize the Spelling and Grammar features 
• Tools menu / Options / Spelling & Grammar tab 

Troubleshooting 
Many problems that occur are due to inconsistencies in the data entry.  Word XP provides two power 
tools to help troubleshoot when these situations occur. 

Show Hidden Characters 
To view characters such as the Tab, Enter, and Space 
• Click the Show/Hide button 

Reveal Formatting 
A new feature in XP that displays the formatting details of the currently selected text. 
1. Select the text to review 
2. In the Task Pane, choose Reveal Formatting 

3. The formatting details are listed in the Task Pane 

Fixing Mistakes 

Undo and Redo: Might be your best friends 
Each click on the Undo button erases the most recent action.  
 

Click on the drop-down arrow immediately to the right of the Undo 
button provides a list of the most recent actions, allowing a user to undo 
multiple steps in just one click. 
The Redo button reverses an Undo action 
 

Tip: Click on the ? and 
then click on an option to 
learn more about it 



Illinois Wesleyan University – Department of Information Technology 

Page 6 of 15 © tjm2001 

Automated Features in Word 

Smart Tags (New for Office XP) 
Provide options for actions just taken 
Two examples: 

AutoCorrect 
A very useful tool that either corrects user error or automatically replaces one string of text with another 
Examples: “(c)” becomes “©”; “THe” becomes “The”  

Review the Current AutoCorrect Settings 
• Open: Tools / AutoCorrect Options / AutoCorrect tab 

Enter a Custom AutoCorrect Entry 
1. In your document, type a word or short phrase and format it as desired 
2. Select the word or phrase 
3. Open the AutoCorrect options: Tools / AutoCorrect Options / AutoCorrect tab 
4. Your formatted text should appear in the dialogue box 

Auto Format as You Type 
The feature that changes the formatting of your text as you are typing 
Examples: “1/2” becomes “½”, creates automatic numbered lists when a line starts with a number 

Access the Settings 
• Open menu Tools / AutoCorrect Options / Auto Format as You Type 

After pasting the word 
“Word”, a Smart Tag 
appears with hidden 
options.  Click once on the 
Smart Tag for the options 

A blue double-
line indicates that 
MS Word auto- 
capitalized the 
word “The” 

Pause on the 
blue lines 
and click for 
the options 

Enter a short and unique 
string to represent the 
entry 
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AutoText 
Allows blocks of text to be stored and then easily retrieved using a few keystrokes.   
Example: A user prefers to close their letters with the same last paragraph and signature.  This complete 
block of text can be stored and retrieved whenever needed in the future (complete with formatting). 

Create an AutoText Entry 
1. In a Word document, enter and format the text to repeat in the future 
2. Select the block of text 

  
3. Open the menu Insert / AutoText / New 
4. A dialogue window appears 
5. Assign the block of text a short and unique name (minimum 4 characters)  
6. Click the OK button 

Insert an AutoText Entry into a Document 
1. Place the insertion point at the proper location in the Word document 
2. Start typing in the name you assigned it (from step #4 directly above) 
3. When the ScreenTip appears on the screen, press the Enter key 

Alter an AutoText Entry 
1. Enter and format the text correctly in a Word document 
2. Follow the steps in the Create an AutoText Entry section above 
3. Over-ride the previous entry when prompted 
 

Selecting Text 
There are many diffeent methods for selecting (highlighting) text 

Click and drag over the text 
By default, Word has the Select Entire Word option activated 
• Tools / Options / Edit tab 

Keyboard 
1. Place the cursor at the beginning or end of the text to select 
2. Hold down the Shift key and then press the appropriate arrow key on the keyboard 

Selection Bar 
Area of space in the left margin (see picture) 
The cursor points north east when it is in this area 
• Single-click selects the line 
• Double-click selects the paragraph 
• Triple-click selects the document Selection 

Bar Area
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New Selection Tools for Word XP 

Non-Continuous  
1. Select a range of text 
2. While holding the Ctrl key down, select any other range 
3. Repeat as needed 

Select Similar Text 
1. Right-click on a section of text 
2. Choose “Select text with Similar Formatting” 

Formatting 
Formatting is controlling how an object appears.  When dealing with text, there are two primary types of 
formatting: character and paragraph.   

Apply Character Formatting 
This formatting applies to any single or group of characters.  Common example are Bold and Italic. 

Many of the quick formatting tools are located on the Formatting Toolbar 
 
For the complete set of formatting options 
1. Highlight the text 
2. Right-click the selection and choose Font 
 

Apply Paragraph Formatting 
As the name suggests, this formatting applies to the entire paragraph the insertion point is located within 
when the format is applied.  Common examples are line spacing, and alignment. 
Many of the quick formatting tools are located on the Formatting Toolbar 

 
For the complete set of formatting options 
• Right-click inside the paragraph and choose the Paragraph option 

Format Painter 
A GREAT tool for “pasting” the formatting from one section of text to another 
1. Select the text with the correct formatting 
2. Click the Format Painter button  
 
3. Click and drag of the text that you want to format 
Tip: Double-clicking the Format Painter button keeps it locked on until it is clicked again 
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Moving and Rearranging Text 

Cut, Copy, Paste 
Cut [Ctrl+X]: Removes the selected item and places it on the Office Clipboard 
Copy [Ctrl+C]: Leaves the selected item intact and places a duplicate on the Office Clipboard 
Paste [Ctrl+V]: Inserts the last item cut or copied in the location of the insertion point (also see the 
Office Clipboard section for additional methods of Pasting) 

Office Clipboard 
Most previous versions of MS Office only allowed one item in the clipboard at a time.  Office XP allows 
24 different clips to be stored at one time and the user can insert them in any order.   
Tip:  The clipboard empties when all Office applications are closed 

Access the Office Clipboard 
The Clipboard is an option in the Task Pane 
It can also be accessed through the Edit menu and choosing Office Clipboard 

Insert or Remove an Item from the Clipboard 
1. Place the insertion point in the desired location in your document (this does not apply to deleting a 

clip) 
2. Place the Mouse Pointer over the desired clip and click the downward pointing arrow 

3. Make your selection 
 

Icons represent what type of file the 
clip is 
 
 
Thumbnail represents the actual 
content of the clip 

Click to erase complete contents of Clipboard 
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Drag and Drop Text 
As it indicates, this method moves text by simply using the 
mouse to drag it from one location and dropping it on another. 
1. Select the text to move or copy 
2. Place the cursor over the text 
3. Right-click and drag the text to the new location 
4. Release the right mouse button and make a choice 
 

Controlling the Placement of Text on a Page 

Margins and Paper Orientation 
1. Open the menu File / Page Setup 
2. Explore the options and tabs available 

Tab Stops 
The tab stop indicator is located to the left of the horizontal ruler 
Click it to change the tab stop type 
Tip: Tab Stops apply either to the selected text or to the line the insertion point is located 

Set a Tab Stop 
1. Confirm the appropriate Tab Stop is in view 
2. Place the tip of the mouse pointer in the lower portion of the ruler and click once 

Tip: Double-clicking results in two tab stops being inserted (makes a mess of things) 
3. The Tab Stop should appear in the horizontal ruler 
4. Press the Tab key on the keyboard to move the insertion point to the Tab Stop 

Move a Tab Stop 
1. Place the tip of the mouse pointer over the Tab Stop in the ruler 
2. Wait for the screen tip to indicate you are pointing at a Tab Stop 
3. Click and Drag the Tab Stop to the new location 

Remove a Tab Stop 
Place the tip of the mouse pointer over the Tab Stop in the ruler 
Wait for the screen tip to indicate you are pointing at a Tab Stop 
Click and Drag the Tab Stop down into the document 

Advanced Tab Options 
1. Select the range of text with the Tabs to format further 
2. Open the Format menu and choose Tabs 
3. Refer to the Word Help system for additional information 

Left Center Right Decimal Bar Covered in the Indent 
section below 
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Indents 

Indents Using the Tab Stops  
Indents can also be set using the Tab Stop options pictured below.  Set them the using the same method 
as you would for a typical tab Stop. 

Breaks (not the coffee kind) 
Breaks can be used to create a new page in a document, divide columns, or divide a document into 
sections (sections are covered in advanced topics) 
 
Inserting a Break 
1. Place the insertion point at the location for the break 
2. Open the menu Insert / Break 
3. Make the appropriate choice 
Tip: Breaks can be seen on the screen by showing the hidden characters  

Pause the mouse over each item in 
the ruler to determine its purpose 

An example of a ½” 
Left Indent 

An example of a ½” 
Hanging Indent 

An example of selecting the 
middle paragraph and then 
moving both the Left and Right 
indents in approximately 1” to 
offset that paragraph. 

1st Line 
Indent 

Hanging 
Iindent 
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Multiple Columns 
Multiple columns in Word are very easy. 

 
1. Select the text to be placed into multiple columns 
2. Open the menu Format / Columns 
3. Use the options provided to format your columns accordingly 
Tip: use the Break function to precisely control how text flows from one column to the next 
 

Headers and Footers 
1. Open the menu View / Header and Footer 
2. The Header Footer toolbar appears, the document text dims, and the Header and Footer become 

outlined 

 

 
Pause the mouse pointer over each button to learn what action it performs 
 
Simple Footer Example:  
Place the page number in the bottom right corner of each page 
1. Switch to the footer section 
2. Click the Insert AutoText drop down arrow and choose “Page X of Y” 
3. Align the text on the right side using the right-align button on the Formatting Toolbar 
4. Click the Close button on the Header Footer Toolbar to return to the document text 
Tip: Word does support different first page and odd/even headers and footers.  To activate these options 
open the men File / page Setup / Layout tab and consult the Word Help for more information. 
 

Header section 
active 
 
Document text 
dimmed

Click and 
drag the 
edges to 
resize 
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Lists: Bulleted or Numbered 
Word is very good at creating lists. 
Use bullet lists for: 
No need for a specific order 
The items are of relatively equal importance 
Options to choose from 

Use number lists for: 
Step-by-step instructions 
Ranking of items 
The ability to reference back to a specific item 

 
Tip: Each item on a list is separated by the Return or Enter key.  Use a manual line break to obtain a 
new line without a new list item 

Creating a List 
1. Enter the items of the list 
2. Select the list 
3. Click the Numbered or Bulleted List button 

 

Customizing a List 
1. Select the List 
2. Open the menu Format / Bullets and Numbering 
3. Use the tabs provided to access the available options 

4. Click the Customize button to access all definable aspects of a list 
5. Use the help button (?) in the title bar to learn more about each option 

Tables 
Due to the depth of the Table tool, this guide will cover the simple Table features only. 
Often, the need for tables can be avoided by proper use of Tab Stops.  However, there are occasions 
when Tables are the best solution. 

Insert a Table 
1. Place the insertion point where the Table is required 
2. Open the menu Table / Insert / Table 
3. An Insert Table dialogue window opens 
4. Use this table to set the parameters for the table 
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Formatting a Table 
Most common table tools are located on the Table and Borders toolbar 
1. Open the Tables and Borders Toolbar (right-click any other toolbar) 

2. Pause the pointer of the mouse over each button to learn about its function 
3. Place the insertion point within a table cell (or select a range of them) and apply the formatting of 

choice 
Tip: The alignment button is very helpful  

Delete a Column or Row 
1. Place the insertion point within a cell that is within the Column or Row to be deleted 
2. Open the menu Table / Delete and make the appropriate choice 

Insert a Column or Row 
1. Place the insertion point within a cell 
2. Open the menu Table / Insert and make the appropriate choice 

Graphics 
Over the years, Word has continued to migrate from a basic word processor into a fairly powerful 
desktop publishing software.  Inserting images into Word is very simple; however, the manipulation of 
those images typically requires dedicated training.  Please see the Word Help or attend further training 
from IT for additional information. 
 

 
 

Access Graphic Properties 
1. Right-click the graphic 
2. Choose the Format option 

Graphics 

Existing Images User Created in Word 

Clip Art Personal Files Use the Drawing Toolbar 

Insert / Picture / Clip Art Insert / Picture / From File 
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Print Window 
Important: The Print Button in the Standard Toolbar IS NOT the same as File / Print 
 
1. Open the menu File / Print 
2. From this menu, the user can control the printer being used, the pages being printed, the number of 

copies and more. 
 

Envelopes From Letters 
New for Word XP 
The new version of Word can automatically add an envelope to the beginning of a letter. 
 
1. Select the mailing address within the letter 

2. Open the menu Tools / Letters and Mailings / Envelopes and Labels 
3. Enter the return address as appropriate 
4. Click the access the Font and Printer settings 
5. Click OK to return to the main Envelopes and Labels window 
6. Click Print or Add to Document 
 

Help 
• Significant help is available under the Help menu 
• The Ask a Question Box is always available in the top right corner 


